AUGS

Web Data Entry Tool

User Manual

Version 1
## Contents

1. **INTRODUCTION** .................................................................................................................. 1

1 **ACCESS TO THE APPLICATION** ....................................................................................... 1

1.1 **LOGIN SCREEN** ................................................................................................................. 1

1.2 **FORGOT PASSWORD?** ......................................................................................................... 2

1.3 **RECOVERY LINK** ............................................................................................................... 2

1 **WEB DATA ENTRY TOOL** ..................................................................................................... 3

1.1 **WEB DATA ENTRY** ............................................................................................................. 4

1.1.1 **Performance** .................................................................................................................... 4

1.1.2 **Patient Information** ........................................................................................................ 4

1.1.2.1 **Add New Patient** ....................................................................................................... 5

1.1.2.1.1 **Add Visit Information** ........................................................................................... 8

1.1.2.1.2 **Update Information** ............................................................................................... 12

1.1.2.1.2.1 **Update Visit** ..................................................................................................... 13

1.1.2.1.2.2 **Update Patient Record** ...................................................................................... 15

1.1.2.1.3 **Remove** ................................................................................................................... 18

1.1.2.1.3.1 **Remove Patient Record** ................................................................................... 18

1.1.2.1.3.1.1 **Remove Patient Record with No/Single visit** ................................................... 18

1.1.2.1.3.1.2 **Remove Patient Record with Multiple Visits** .................................................. 20

1.1.2.1.3.2 **Remove Patient Visit** ......................................................................................... 21

1.1.2.2 **Notification** .............................................................................................................. 22

2 **GLOSSARY** ......................................................................................................................... 24
1. Introduction

AUGS Registry has **Single Practice-Single Provider** Sign-Up Portal.

This user manual provides steps to

- Add / Edit / Delete Patient records.
- Add / Edit / Delete Patient Visit records.
- Nullify / Minimize the Notifications received.

1. Access to the Application

- Open a web browser (e.g. Google Chrome, Mozilla Firefox, Internet Explorer)
- Type or copy paste the URL [https://aquire.augs.org/Dashboard/login.aspx](https://aquire.augs.org/Dashboard/login.aspx) in the browser.
- Enter the Username and Password received while **Signing Up** with the Registry.
- Select **Web Data Entry Tool** from the Drop-down.
- Click on the **“Login”** button

1.1 Login Screen

*Figure 1: Login In Window*
1.2  Forgot Password?

Click “Forgot Password” link to open ‘Login Support’ window to reset the password.

![Login Support Window](image)

The password may be reset at any time by submitting a request using the registered email address.

1.3  Recovery Link

The recovery link is sent to the registered email account.

The Login Screen is displayed again after the new password has been reset

Successful Login displays the landing page allowing the User to access the ‘Web Date Entry Tool’.
1 Web Data Entry Tool

Select ‘Web Data Entry tool’ from the Left Pane to display ‘Web Data Entry’ in the Right Pane.

Figure 3: Web Data Entry Tool Landing Page

Figure 4: Web Data Entry Screen
1.1 Web Data Entry

This screen has two sections

1. Performance
2. Patient Information

1.1.1 Performance

This section will display the data in the table ONLY after the Patient and Patient Visits information is added:

- Measures applicable for the Provider
- Provider’s performance in the form of bar graph
- Number of Measures which meet the criteria.
- Number of Measures which do not meet the criteria.
- Number of Exclusions for the applicable measures
- Number of Exceptions for the applicable measures

![Performance Section in Web Data Entry Screen](image)

1.1.2 Patient Information

This section displays Patient records allowing the Provider/ User to

- Add, Edit, Delete Patients
- Add, Edit, Delete Patient Visits
Details of the Patient Information Table

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Name</td>
<td>First Name of the Patient</td>
<td>Text</td>
</tr>
<tr>
<td>Last Name</td>
<td>Last Name of the Patient</td>
<td>Text</td>
</tr>
<tr>
<td>Date of Birth</td>
<td>Date of the Birth of the Patient</td>
<td>mm-dd-yyyy</td>
</tr>
<tr>
<td>MRN</td>
<td>Unique Medical Record Number of the Patient</td>
<td>Numeric</td>
</tr>
<tr>
<td>Update Information</td>
<td>Allows the Provider/User to update/edit Patient Information</td>
<td>Icon</td>
</tr>
<tr>
<td>Add New Visit</td>
<td>Allows the Provider/User to Add New Visit for the Patient</td>
<td>Icon</td>
</tr>
<tr>
<td>Remove</td>
<td>Allows the Provider/User to delete Patient record from the Patient Information Table</td>
<td>Icon</td>
</tr>
</tbody>
</table>

1.1.2.1 Add New Patient

This button allows the User to add a New Patient record.

- Click ‘Add New Patient’ button present near the upper right corner of the ‘Patient Information’ table.

![Figure 6: Patient Information Section in Web Data Entry Screen](image)

![Figure 7: Add New Button in Patient Information Table](image)
Click Add New Patient ➔ Add New Patient Information window

![Add New Patient Information Window](image)

## Details of the Add New Patient Information

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Medical Record Number *</td>
<td>Unique identification number assigned to the Patient</td>
<td>Alpha- Numeric</td>
</tr>
<tr>
<td>Date Of Birth *</td>
<td>Date of Birth of the Patient</td>
<td>mm-dd-yyyy</td>
</tr>
<tr>
<td>First Name *</td>
<td>First Name of the Patient</td>
<td>Text</td>
</tr>
<tr>
<td>Middle Name</td>
<td>Middle Name of the Patient</td>
<td>Text</td>
</tr>
<tr>
<td>Last Name *</td>
<td>Last Name of the Patient</td>
<td>Text</td>
</tr>
<tr>
<td>Insurance Type</td>
<td>Insurance availed/adopted by the Patient.</td>
<td>Drop-down</td>
</tr>
<tr>
<td></td>
<td>Available options</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Medicare as secondary payer</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Medicare Part B</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Railroad Retirement Board</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Other Payer (Private Insurance, Medicare Advantage Plans, etc.)</td>
<td></td>
</tr>
</tbody>
</table>

The fields marked by Red Asterisk (*) are mandatory.
**Cancel Button:** Closes the window without saving the entered patient information.

**Save and Proceed to Visit Information Button:**

- Saves the Patient Information in the “Patient Information” table and proceeds to the Visit Information window.

![Patient Information Table with Patient Records](image)

*Figure 9: Patient Information Table with Patient Records*

- A message “Record Saved Successfully” is displayed at the top of the screen.

![Add Visit Information](image)

*Figure 10: Message Record Saved Successfully*

- “Add Visit Information” window is displayed to add a visit record for the saved patient.
1.1.2.1.1 Add Visit Information

Allows the User to add Patient visit for existing and new patients.

There are two ways to add a Patient visit(s)

1. **Add New Patient** button *(for New Patients)*

   ![Add New Patient Button](image)

   Figure 11: Patient Information Table to Add New Visit to the Existing Patient

2. **Green** Plus (+) Sign in the **Patient Information Table** *(for existing Patients)*

   ![Green Plus Sign](image)

   Figure 12: Plus (+) Sign in Patient Information Table

---

**Add Visit Information Window**

- Select date from the Calendar

![Add Visit Information Window](image)

Figure 13: Add Visit Information Window
This displays additional sections with questions common to all ages and pertaining to:

- Diagnosis
- Procedure
- History
- Intraoperative
- Postoperative

![Figure 14: Add Visit Information Window with Additional Questions](image)

For the patients 18 years and above few additional questions are added.
For every Yes answer in the Procedure section, additional questions are displayed.

**Brief explanation of the working of each button on the screen.**

![Button Options](image)

**Reset button:** displays the confirmation screen.

- **Yes Button** - displays screen to re-enter the Patient Visit Information.
- **Cancel Button** - retains the entered Patient Visit Information.

![Confirmation Screen](image)

**Save button:**

- Saves the Patient Visit Information but is not reflected in the Patient Information table.

**Cancel button:**

- Navigates the User to the main screen without saving entered information.

**Save and Complete button:**

- Updates the Patient visit in the ‘Patient Information’ table
- Closes the ‘Add Visit Information’ window and navigates the User back to the main screen.
- Saves the patient Visit Information and the visit information record is added to the ‘Patient Information’ table.

A message “Visit Information saved successfully” is displayed on the top of the screen.
- Performance section displays **Performance of the Provider** for the applicable measures in the form of **Bar Graph**.

![Image of Performance Graph]

*Figure 15: Message Visit Added Successfully and Performance of the Provider*
1.1.2.1.2 Update Information

This button allows the User to update the incomplete ‘Patient Visit’ information and ‘Patient Record Information’.

Click ‘Update Information’ icon present in the Patient Information table against a specific Patient record.

![Figure 16: Patient Information Table with Update Information Icon](image)

Patient Information Table ➔ Update Information Icon ➔ Visit Information Window

![Figure 17: Visit Information Window with Visit Records of the Selected Patient](image)
1.1.2.1.2.1 Update Visit

This icon allows the User to update visit details of an existing patient.  
Click ‘Update Visit’ icon present in the row for the selected patient.

![Visit Information Window with Patient Record Selected for Updates](image)

Figure 18: Visit Information Window with Patient Record Selected for Updates

Patient Information Table ➔ Update Information Icon ➔ Visit Information Window ➔ Update Visit Icon

This displays ‘Update Visit Information’ window.
Update the incomplete section(s) in the displayed window.

Figure 19: Update Visit Information Window
1.1.2.1.2.2 Update Patient Record

This button allows the User to ‘Update Patient record’ information.

- Click ‘Update Patient’ button present on the top right corner of Update Visit Information window.

![Figure 20: Update Visit Information Window with Update Patient button](image)

- Patient Information Table → Update Information Icon → Visit Information Window → Update Visit Information window → Update Patient Button → Update Patient Information window
This displays **Update Patient Information** window.

![Update Patient Information Window](image1)

**All the fields displayed in the Update Patient Information are editable.**

**Cancel button:** Navigates the **User** to **Update Visit Information** window.

**Save and Proceed button:**

Updates the changes made in **Update Patient Information** screen. The changes are reflected in 2 places

1. **Update Visit information** window

   A message **Record updated successfully** is displayed on the top of the screen.

![Message - Record Updated Successfully](image2)
2. Visit information table

![Visit Information Table]

Figure 23: Updated Records in Visit Information Table
1.1.2.1.3 Remove

This icon allows the User to remove/delete the ‘Patient Record information’ and ‘Patient Visit Information’.

Remove Icon

Patient Information table

---

1.1.2.1.3.1 Remove Patient Record

Removes the Patient record from the Patient Information table.

**Note** - If patient has multiple visits, then User is navigated to the Visit Information Window for further action.

1.1.2.1.3.1.1 Remove Patient Record with No/Single visit

If a patient has no visit or only a single associated with it, then the Patient record can be deleted from this screen by clicking on the ‘Remove’ icon present in front of the selected patient record.

Figure 24: Remove Button in Patient Information Table

![Patient Information Table](image)

Figure 25: Patient Record Selected in Patient Information Table
This displays confirmation window to delete the selected record.

![Confirmation window](image)

**Figure 26: Confirmation Window for Removal of a Record**

**Cancel button:** Retains the selected patient record and navigates the User to the Patient Information table.

**Yes button:** Deletes the selected Patient record.

A message ‘Record removed successfully’ is displayed on the top of the screen.

![Success message](image)

**Figure 27: Message - Record Removed Successfully**
1.1.2.1.3.1.2 Remove Patient Record with Multiple Visits

If a Patient has more than 1 visit, then all the visits need to be deleted first, and only then will the Patient record get deleted.

- Select a patient record having multiple visits from ‘Patient Information’ table.
- Click Remove icon present in the selected patient record row.

Patient Information table ———> Remove Button ———> Visit Information table ———> Remove Icon ———> Confirmation Window ———> Remove Button in Patient Information Table

Please refer to the steps in **Remove Patient Visit**

- Remove all the records one by one pertaining to the selected patient.
- After all the visit records are deleted, click Remove icon present in the ‘Patient Information’ table for the selected patient record.

This displays ‘Confirmation’ screen to delete Patient record from the ‘Patient Information’ table.

Yes button: Deletes the patient record from the ‘Patient information’ table.
Cancel button: Retains the patient record.
1.1.2.1.3.2 Remove Patient Visit

- Click ‘Remove’ icon present in the selected patient’s row in Patient Information table. This displays ‘Visit Information’ table for the selected patient.

![Visit Information Table](image1)

**Figure 291: Reduced Patient Visits in the Visit Information Table**

- Click Remove icon for the selected visit. This displays a Confirmation screen to delete the selected visit.

![Confirmation Window](image2)

**Figure 302: Confirmation Window to Delete the Selected Patient Record**

**Cancel Button** – Retains the visit selected for deletion.

**Yes Button** – Deletes the visit selected for deletion from the Visit Information table.

A message ‘Record removed successfully’ is displayed on the top of the screen.
1.1.2.2 Notification

Notification is displayed after 30 days of a visit date, only if any of the sections in the Visit Form have been left blank.

It indicates the number of incomplete Patient visits’ form after 30 days of Visit Date.

- Click on the notification icon to view Patient Records that need to be updated.

- Click “Date of Service” to update the patient visit record.

This displays ‘Update Visit Information’ window.
Reset Button: Displays fresh screen to re-enter the visit information.

Save Button: Saves the data but is not reflected in the database, allows future editing and continues to display notification.

Save and Complete Button:
- Saves the updates made in the “Update Visit Information” window.
- Freezes the patient “Visit Information” and prevents future editing
- Reduces the number of notifications.

A message “Visit information saved successfully” is displayed near the top of the screen.

![Figure 34: Message Visit Information Saved Successfully](image)

This concludes the User manual for **AUGS Web Data Entry Tool**
## 2 Glossary

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✍️</td>
<td>Allows the User to Update/Edit Patient Record and Patient Visit Record</td>
</tr>
<tr>
<td>🍀</td>
<td>Allows User to Add Visits to the Existing Patient</td>
</tr>
<tr>
<td>🗑️</td>
<td>Allows the User to Remove Patient Information and/or Patient Visit Information</td>
</tr>
<tr>
<td>📦</td>
<td>Allows the User to Sort the Patient Information and Patient Visit Information</td>
</tr>
<tr>
<td>🔍</td>
<td>Allows the User to search Patient Information based on MRN, Date of Birth, First Name and Last Name</td>
</tr>
<tr>
<td>🏡</td>
<td>Allows the User to Update Patient visit</td>
</tr>
<tr>
<td>🌟 Add New Patient</td>
<td>Allows the User to Add New Patient to the Practice</td>
</tr>
<tr>
<td>✔️ Save and Proceed to Visit Information</td>
<td>Allows the User to Save the Newly Added Patient Records and Enter the Patient Visit Details in Visit Information Window</td>
</tr>
<tr>
<td>🔍 Update Patient</td>
<td>Allows the User to update existing Patient information</td>
</tr>
<tr>
<td>🔄 Reset</td>
<td>Presents fresh screen, allowing the User to re-enter the Patient information or Patient Visit Information</td>
</tr>
<tr>
<td>🔄 Save</td>
<td>Saves the Patient Information and Patient Visit Information, but the information is not reflected in the database.</td>
</tr>
<tr>
<td>🔄 Save and Complete</td>
<td>Saves the Patient Information and Patient Visit Information in the database and prevents future editing.</td>
</tr>
<tr>
<td>🔄 Cancel</td>
<td>Retains the previously entered patient and patient visit information.</td>
</tr>
</tbody>
</table>